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Important Notices and Disclaimers
In order to properly use this product, please carefully read this manual
before using.

- All rights of this manual belong to T&D Corporation. It is prohibited to
use, duplicate and/or arrange a part or whole of this manual without the
permission of T&D Corporation.

Microsoft and Windows are registered trademarks of Microsoft Corpora-
tion in the United States and/or other countries.

Specifications, design and other contents outlined in this manual are sub-
ject to change without notice.

Please follow the safety precautions outlined in this manual carefully.

We cannot guarantee nor are we responsible for safety if this product is
used in any manner other than was intended.

- On-screen messages in this manual may vary slightly from the actual
messages.

Please notify the shop where you purchased this product or T&D
Corporation of any mistakes, errors or unclear explanations in this
manual.

- T&D Corporation accepts no responsibility for any damage or loss of
income caused by the use of our product.

- This product has been designed for private or industrial use only.

It is not for use in situations where strict safety precautions are necessary
such as in connection with medical equipment, whether directly or
indirectly.

We are not responsible for any malfunction or trouble caused by the use
of our product or by any problem caused by the use of measurement
results of our unit. Please be fully aware of this before using our product.

- This manual cannot be reissued, so please keep it in a safe place.
- Please read the warranty and provisions for free repair carefully.



Safety Precautions and Instructions

Safety Precautions and Instructions

The following items should be strictly obeyed for the safe usage of this
product, and for protecting yourself and other people from bodily harm
and/or damage to property.

Explanation of Symbols

Warning Symbols

Failure to follow the instructions with this symbol
could cause serious injury or even death.

A\ DANGER

Failure to follow the instructions with this symbol
A CAUTION could cause personal injury or physical damage
to equipment.

Picture Symbols

A Denotes an important warning or caution.

® Denotes a forbidden action.

' Denotes an action that should be carried out.




A DANGER To Prevent Serious Accidents

Do not disassemble, repair or modify the unit and accessories.

© e

Do not use the unit in any environment that is exposed to
chemicals and harmful gases. Doing so may cause corrosion and/
or other danger to the unit. Also, coming in contact with hazardous
substances may cause bodily harm to the user or people nearby.
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This unit is not water resistant. If water or a foreign object enters
the case, immediately unplug the AC adaptor and stop using it.

Do not handle the unit, remove batteries or cables with wet hands.

This product has been designed for private and/or industrial use
only. It should not be used in situations where strict safety
precautions are necessary such as with medical equipment, or in
systems directly or indirectly connected with human life or
well-being.

Do not drop or expose the unit to a strong impact.

Do not cut or process the cords for the communication cables.
Also, do not twist, pull on or swing any of the cords.

To prevent damage to the unit from static electricity, remove static
electricity from your body by touching metal around you (such as a
door knob and window frame) before touching the unit.

Place and store the unit and accessories out of the reach of
children.
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Do not use any power, battery, sensor, or cable other than those
specified by T&D Corporation.




We are not responsible for any damage, malfunction or trouble,
whether direct or indirect, caused by the use of our product.

Do not put anything on top of the cable. This may cause overheat-
ing.

Do not disconnect the USB cable during USB communication.
Doing so may cause adverse effects to the unit and/or PC.

Make sure that all cable plugs are inserted fully, so as not to cause
an improper connection. Also, when unplugging the cable from the
unit, do not pull the cord, but hold the connector to disconnect.

If the unit produces heat, emits smoke or a strange smell, or makes
unusual noises, immediately remove the batteries, unplug the
power, and stop using it. Also, unplug the unit from the PC.

If the unit is not to be used for a long period of time, remove
batteries. If left in the unit, the batteries may leak and lead to
malfunctioning. Install new batteries when starting or re-starting to
use a unit.

Make sure that there is no magnetic media or materials within one
meter from the device.

Magnetic materials may cause damage to data stored in magnetic
media.
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Do not remove the SD card or turn off the power while writing data
to the SD card. This may result in damage to data.




A\ CAUTION Do not place or store in the following areas:

* Areas exposed to direct sunlight

* Areas exposed to excessive heat or high temperatures such as near fire or
heating equipment

* Areas exposed to static electricity

* Areas exposed to strong magnetic fields

* Areas exposed to dampness

* Areas subject to condensation or wet areas

* Areas exposed to excessive vibration

* Areas exposed to excessive smoke, dust or dirt.

/N3] BN Other Precautions

e Use the unit in the specified operating environment. Do not use it for any
purpose other than for which it was designed.

* Condensation may occur inside the case when a unit is moved from one
environment to another where there is a great difference in temperature.

* Do not use the unit in wet areas or places exposed to water such as
bathroom.

* When connecting the unit to your PC, make sure to follow all warnings
and directions from your computer manufacturer.

¢ We shall not guarantee the unit's operation if it has been connected to a
PC using a USB hub or a USB extension cable.

¢ Please take extra caution when plugging in and pulling out the USB plug
while another USB device such as CDD or HDD is in operation.

* Do not insert any foreign objects into any of the units' jacks.
o If the unit gets dirty, wipe it with a clean cloth.
* Make sure to remove dust and dirt from plugs of any cables.

¢ Battery terminals may provide insufficient contact due to age or vibration.
This may lead to data loss.

e If the unit is not to be used for a long period of time, for safety reasons
please remove the battery. If left in the unit, the battery may leak and lead
to malfunctioning.

e When an SD card is not inserted, insert the supplied card slot cover to
prevent the intrusion of dust.



Before Using this Product

Please be careful about the procedures for Installation.

(For USB communication between your computer and a
MCR-4TC)

In order to use a USB connection to communicate between the unit and
a computer, it is necessary to install the software and the USB device
driver.

Make sure to first install the software before connecting the unit to a

computer. If you connect the unit first, the USB device driver may not
be installed properly.

If you have connected the unit to your computer before installing the
software, make sure to click [Cancel] in the Wizard window when it
pops up on the computer display. Then disconnect the USB communi-
cation cable from the unit.
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Overview

The MCR-4TC Multichannel Temperature Recorder is designed to
measure a wide range of temperatures using a thermocouple sensor.
After it measures and records temperature, the data can be easily
displayed in graph form, enabling the immediate on-the-spot checking
of continually-changing data.

H Measure and Record
H Use MCR for Windows for

Device Settings
Recording Settings
Downloading Recorded Data

M Use T&D Graph for
Graph Display
Data Analysis
Printing and Saving in Text

SD Memory Card
or
USB Connectiol

JANC
# M Main Features in Rec Settings
Recording Mode
Recording Method
B Measurements Recording Interval

and Trend Graph  Recording Channel

M Coupling Image

Master =~ ——— Slaves —

Throughout this manual, the MCR-4TC is also referred to as “the
device” or “the unit”.



Appearance Diagram and Part Names

T

[FRONT]

[BOTTOM]

MBINBAQ

o [T Mo

o

[SIDE] [BACK]

1. Input Terminal

2. Coupling Lug

3.LCD Display

4.Touch Panel (touchpad and
control wheel)

5. SD Memory Card Slot

6. USB Port

7.Battery Cover
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Explanation of Buttons

AV

Press to change the selected menu or settings item (by going
up or down), and to increase or decrease the values shown in
the LCD.

Press to confirm the selected menu, operation, or value.

Press to jump to the [Start Recording] or [Stop Recording]
menu.*

Press to return to the previous screen in the menu or cancel the
current operation.*

O O @

Press and hold to turn the power ON/OFF.

I}
[
3
5

Press to switch the display between [Menu] - [Measurements]
- [Trend Graph].

Press to switch between the touchpad operation and control
wheel operation. Press and hold to switch the key lock ON/OFF.

* Will not function when operating by control wheel.



MBINBAQ

Touch Panel Operation Methods
There are two ways to operate the touch panel as follows:
- Touchpad operation

- Control wheel operation

Terms and gestures related to operations

Tap (touch) Press-and-hold Control Wheel
Tap desired area of (hold down) Operation (rotate)
touch panel. Touch the screen and Press and rotate the
hold finger in place control wheel (white
for a few seconds. circular area).
Mainly used to switch  Clockwise
ON/OFF the power movement moves A
and key lock. (up) and counter-

clockwise movement
moves ¥ (down).
IMPORTANT

- During operation, if none of the above gestures are performed for a while, the operation
will be canceled and the screen will return to the original value or previous screen.

- Make sure to use a bare finger to operate the touch panel. If you use the tip of your
fingernail, gloves, or touch pen, touch panel operations may not be recognized.

Auto Power Off Function
If the device is not used for about three minutes, it will automatically turn
off to save battery power. However, the Auto Power Off function will be
disabled in any of the following situations.

- When a recording session is in progress
- When measurements or trend graphs are displayed on the screen
- When running on external power

11
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LCD Display and Icons

The following contains some brief explanations about icons. Each menu
will be explained later in the “Menu List” pages.

12 3 4 56
IIIIII

LI T T
STP 1 AsecCHI 22 40MhaTy
Export Selected Data

*MoS  71Z.01. 10 09307134
H: 1 20

)

- 01 LCD backlight will be ON
O el v o2 1212, 25 17257435

during operation.

1 Recording Status | Shows the recording status.

REC: Recording in progress STP: Recording stopped
PRG: Waiting for programmed start IMM: Preparing
immediate start

2 Recording Mode | Shows the recording mode.
T : Endless mode
|—#1 : One-Time mode

3 Recording Shows the recording interval.
Interval ms: millisecond(s)
sec: second(s)
min: minute(s)
When the recording method is Average, “Aver.” and the
recording interval are displayed alternatingly.

4 Recording Channel | Shows the channel(s) being measured and recorded.

5 Battery Mark Shows source of power and battery level

4/ Battery Mark (Alternating Display): Running on
external power

Battery Mark only (see the next page): Running on
battery

6 Operation Mode | Shows the operation mode status.

Hct : Touchpad operation enabled

2 : Control wheel operation enabled
Lazk: Touch Panel disabled
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7 A" These indicate that there are more menu items above or
below for view. Use A and ¥ on the touch panel to scroll up
and down.

8 g An item marked with an arrow denotes it has been selected.
Use A and ¥ on the touch panel to move the arrow up and
down. Press <ENTER> to execute the selected operation.

A highlighted display shows the item currently selected, and a blinking
highlight shows that an item is being changed.

The battery mark shows the battery level as follows.
A% : Full or near full power
I} Beginning to lose power
I} Significant loss of power
I} Change batteries as soon as possible
E_}: Change batteries immediately
[—F: Not operable with batteries only

Below are some examples of recording conditions and the
corresponding estimated battery life.

4 channels, Instantaneous value, 100-ms interval: About 5 days
4 channels, Instantaneous value, 500-ms interval: About 7 days
4 channels, Instantaneous value, 1-sec interval: About 21 days
4 channels, Instantaneous value, 5-sec (or longer) interval: About 60 days

* Battery life varies depending upon the ambient temperature in which it is used, the
recording interval, the number of channels, and the frequency of data export to a
memory card.

13
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About How Data is Recorded

The MCR-4TC records measurement data to its internal memory. A
recording session is one cycle from recording start to stop, and the
MCR-4TC can record multiple sessions. The number of recording
sessions and number of data readings which can be recorded
depends upon the number of channels, the recording interval and
other settings. In the “n”th recording session, the remaining
memory space is used for recording.

EX: When logging capacity is filled during the 5th recording session:
|—— Internal Memory Capacity

1t 2nd 3 4th 5th
—»‘—»‘—»}—»‘( d

2,000 3,000 5,000 8,000

readings readings  readings readings In Endless mode,
data will be overwritten from the
beginning of the 5th recording
session and recording will continue.

1st  2nd 3rd 4th 5th
‘—»—»
2,000 3,000 5,000 8,000 In One-Time mode,
readings readings readings readings recording will stop.

*

If the memory capacity has not reached full, up to 30 recording sessions can be
made.



Using SD Memory Cards

It is not only possible to transfer data stored in the internal memory
to an SD memory card, but it is also possible to automatically
backup data while recording in endless mode. Operations related
to the use of an SD memory card are as follows:

Copy [
5 toaPC M
Record in internal z
memory

Exporting Data while Recording is OFF (Manual Saving) See p.34 for
details

— [Data List] —[Export Selctd Data]

— [Data List]—[Export All Data]

Copy data to a
memory card

Exporting Data while Endless Recording is ON (Manual Saving /
Automatic Saving) See p.38 for details

— [Data List]—[Expt Curr Data Now]

— [Data List] —[Auto Data Export]

IMPORTANT
- Memory cards are not included. Please purchase separately.
- Measurement data cannot be directly recorded into a memory card.

- Before inserting an SD memory card into the device, make sure to switch off write
protection on the memory card.

- Exporting data to the memory card will not erase it from the device's internal memory.
Delete recorded data in the device as necessary.

Supported Memory Cards
- SD Memory Cards
- SDHC Memory Cards
IMPORTANT

- SDXC memory cards cannot be used.

- Itis possible to run a quick test to see if your memory card works in MCR-4TC. See p.40 for
details.

MBINBAQ
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Using MCR-4TC

. . PC
The following shows the basic flow of procedures. @ .
Use MCR-4TC  Use PC

©)
1. Getting Ready

Install the batteries (see p.17)

B
2. Getting PC Ready

Install the provided software (see p.44)
Connect the device to a PC (see p.46)

vce] o B

3. Setting up the Device (see p.31) / Making Recording Settings (see p.26)

* Recording Settings can be made both on the device and from a PC.

4, Measuring and Recording @ '

5. Viewing Recorded Data in Graph on the Device (see p.35) @ '

Vﬁ
PC
6. Downloading Recorded Data to a PC @ .

Exporting data to an SD memory card for transferring to a PC (see p.34)
Using the supplied software MCR for Windows (see p.48)
* Either of the above can be used to download recorded data to a PC.

“
7. Analyzing Recorded Data on a PC (see p.51)

View Graph, Print, Save in Text

16 When not using a PC, the only necessary steps are 1and 3to 5.



Installing the Battery

Remove the battery cover from the back of the device, and insert
the supplied two AA alkaline batteries as shown in the figure below.
After the batteries are inserted, the [Please set the clock] message

will appear on the LCD. T
* For information on how to set the clock, see p.41. %
Fmmem =7 [MPORTANT 2
o |:| o - Make sure to use new batteries of the same kind. (.:3
- m — - Make sure not to mistake + / -. b
== (15) Y= - Do not insert or change batteries with wet hands. o
[0} @® - Be sure to completely close the cover.
o o - The MCR-4TC cannot recharge batteries.
e f——+

Usable Power Sources

- AA Alkaline Batteries

- AA Ni-MH Batteries

- AC Adapter (USB type)
- USB Bus Power

Changing the Batteries

If the battery runs down before it is replaced, MCR-4TC will
automatically stop recording to protect data. Check the battery mark
(see the previous page) and change batteries as necessary.

IMPORTANT

- To protect data, please stop recording first before changing batteries. Not doing so
may result in loss of data being recorded.

- When you wish to replace batteries while recording is in progress, make sure to
connect the USB cable to your PC for USB bus power.

- If the MCR-4TC runs out of power while processing data on a SD memory card, the
data on the card may be corrupted.

17
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Measuring Temperature

MCR-4TC.

1. Prepare a single wire of @0.32mm to ©0.65mm
(AWG 28-22), or a twisted wire of 0.08mm? to
0.32mm? (AWG 28-22) with a diameter of 0.12mm
or more. Strip about 10mm from its end.

1. Connect the thermocouple wire or thermocouple 10mm \
extension lead wire to the proper terminals of the /%

2. Using a screwdriver or other such tool, while
pressing down on the input terminal button <B> on the top of the
device, insert the wire into the hole <A>.

* Thermocouples have polarity; make sure to
connect in the right way to get a proper
reading.

If the polarity is incorrect, changes in
temperature will be reversed (when the real
temperature increases, the measured
temperature will decrease).

s
’tﬁ;i""l j| [Top Surface]
D {

Enlarged View of
Input Terminal

3. When removing the wire, push down on <B> and gently pull the wire
out of the hole <A>.
* MCR-4TC supports the following thermocouple types: K, R, S, T, and J.
* Temperature can only be measured within the heat-durability range of the sensor
being used.
2. Press <DISPLAY> to switch to the graph display, and view the
measurements in a trend graph.

STPCR1EEANECH]  Emas:

Measurements Trend Graph



About the Measurements Display

The font size used to display the measurements automatically changes
depending on the number of channels.

O1p-dOW Buisn I

* You can change the number of channels by going to the Main Menu and selecting
[Record Settings] > [Rec.Channel].
About the Trend Graph Display

A trend graph is displayed for each channel of data.
— 1
STPCP188msCHL [FuLL 2

h Dil'?s]._—

y=]
||-'I \‘FEEIB &—3
o 1= e&—4
Loddin]

1. Channel for Display
The channel for display can be changed.
Select the measurement channel to view the graph.
2. Scrolling Method
<« Scrolls graph and divisions together.
I: Scrolls graph only.
* The scrolling method can be switched with <ENTER> when none of 1 to 4 are
highlighted or flashing on the LCD.
3. Vertical Axis Scale (max/min)

Specify the range of the vertical axis to be displayed in the graph.
The max and min values can be set in units of 10°C in a range of -300°C
to 1800°C.

EX) “V.AXIS -100, 500” shows that the displayed range of the vertical axis
is from -100 to 500°C.
4. Horizontal Time Scale (time/div)
Specify the value for each horizontal division in sec or min.
EX) “H.Axis 1s/div” shows that each horizontal division represents 1 sec.

* 4. The possible selections for the time scale will change depending on the
measurement interval.

19
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Operating the Trend Graph

Use A and ¥ to highlight the desired item, and tap <ENTER>. While the
selected item is blinking, use A and ¥ again to change the value, and
tap <ENTER>.

* If no operations are performed or a change is not confirmed with <ENTER> while the
selected item is blinking, the operation will be canceled and the selected item will

return to the original value.



Increasing Recording Channels

Up to four units can be coupled together to allow for a maximum of
16 channels.

When the bodies of multiple units are connected, the MCR-4TC at s
the far left side will be automatically designated as the Master and
all other connected MCR-4TC units will be designated as Slaves.

By starting recording on the Master unit, all connected Slave units
will start recording at the same time.

O1p-dOW Buisn

Coupling Image

Turn clockwise.

Coupling of MCR-4TC and MCR-4V is possible.
Refer to the MCR-4V User's Manual for its operating instructions.

IMPORTANT

When using MCR-4V as the Master and MCR-4TC as the Slave, Group Recording
cannot be started if the measurement interval of the Master is less than 100ms.

21
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Storage Location for Group Recording

When performing a group recording for multiple units, recorded data will
be stored in each unit's memory. To analyze recorded data on a PC,
either download data using MCR for Windows, or export data to the SD
memory card to transfer to a PC.

Master Slaves N Master ’ Slaves N

MCR for Windows also makes
it possible to download
recorded data from Master and
all Slave units together.

* All recorded data files downloaded using MCR for Windows will be stored in the
same folder by default. See p.49 for the storage location of recorded data and file
name.



Group Operations via Master

Group operations such as the starting and stopping recording for the
connected units can only be performed via the Master. Upon the start of E—
a group recording, the main recording settings will be temporarily
copied to all connected Slaves. Upon the stopping of recording all
copied settings will be returned to their original state.

Master Slaves

O1p-dOW Buisn

Using MCR for Windows, it is possible
to start and stop recording by group by
connecting the Master to a PC via USB.

Settings Controlled by the Master:
Settings for Recording Mode, Recording Method, Recording Interval,
and Recording Channels

Settings not Controlled by the Master:
Channel Name and Thermocouple Type

IMPORTANT

- Operations related to the SD memory card (such as Quick Format and Memory Card
Test) cannot be performed by group via the Master.

- To change the Thermocouple Type, either change directly on the target connected
Slave unit, or use MCR for Windows and connect each Slave unit to the PC with a USB
cable.

- The Channel Name can only be set or changed via MCR for Windows.

23



Starting Recording by Group

1. Make recording settings for each device separately; no matter if it is a
Master or a Slave.

* See p.26-27 for a list of the possible setting items.

* See p.23 for the settings that are/are not controlled by the Master.

2. From the main menu of the Master, select [Record Settings] - [Start
Recording].

3. For the [Method], select IMMED(grp) or [PGM(grp)].
4. select [OK] and tap <ENTER>.

IMPORTANT
All connected Slaves need to have power switched to ON.

Stopping Recording by Group

From the main menu of the Master, select [Record Settings] - [Stop
Recording].

IMPORTANT

- During Group Recording, if the bodies of the devices are disconnected from one
another, recording will continue on the Master but will stop on the Slave units.

- Even when devices are coupled, power will not be supplied from the Master to any
connected Slave units.

- When the Master stops recording, all Slaves will stop recording.

- During recording in one-time mode, if the Slave's memory capacity becomes full,
recording will stop on that Slave unit.



— Using MCR-4TC
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About Menus

[Recording Settings] Menu

[Back]

Stop Recording

Start Recording

Rec.Mode: Endless
Rec.Method: Instant

Rec.Interval: 10 sec

Rec.Channel: CH1234

CH1 T.C. Type
CH2 T.C. Type
CH3 T.C. Type

CH4 T.C. Type

—> | [Back]

OK

— > | [Back]

OK

Method:
IMMED(indv)

Endless / One Time

Instant / Average

IMMED(indv) /
PGM(indv) /
IMMED(grp) /
PGM(grp)
Month/Day/Year
HH:MM:SS*1

100/200/500ms/1/2/5/10/15/20/
30sec/1/2/5/10/15/20/30/60min

CH1/CH2/CH3/CH4 /CH12 / CH23 / CH34
/ CH13/CH24 / CH14 / CH123 / CH234 /

CH124 / CH134 / CH1234

K/R/S/T/J



Save/Restore Sett.

[Back]

Save Settings1
Save Settings2
Save Settings3
Save Settings4
Restore Settings1
Restore Settings2
Restore Settings3
Restore Settings4

*1: Will only appear when the recording start method is set to PGM (programmed start).

snus|\ 1noqy
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[Data List] Menu

Displayed Items when Recording Stopped:

[Back] * List number, date, and time shown below
are examples.

Display Graph ——> | [Back]

No4 Jul 30 '13 16:19:45
No3 Jul 29 '13 15:42:51

Export Selctd Data | ——— | [Back]

No4 Jul 30 '13 16:19:45
No3 Jul 29 '13 15:42:51

Export All Data —> | [Back]

OK

Delete Selctd Data | —— | [Back]

No4 Jul 30 '13 16:19:45
No3 Jul 29 '13 15:42:51

Delete All Data —> | [Back]
On This Device Only

On All Devices*1

*1: When selecting [Delete All Data] on the Slave unit, the [On All Devices] option will not
appear.



Displayed Items during Endless Recording:

[Back]
Expt Curr Data Now Formatted & Blank Card?
Auto Data Export*1 —> | [Back]
Yes Quick Format
No —> | [Back]
OK

*1: When recording in one-time mode, [Auto Data Export] will not be displayed.

snus|\ 1noqy
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[Memory Card] Menu

[Back]

Quick Format

Memory Card Test

[Back]

OK

[Back]

OK




[Operation Settings] Menu

[Back]
Set Contrast: 65

Check Memory

Set Clock

Beep: ON

Key Lock: OFF

Unit of Temp: °C
Burnout Detect: ON

Return to Default

0to100

—>

[Back]
Memory:

Data:

[Back]
Nov/07/'13 16:43:22
Time Zone GMT+09:00

DST 00:00

ON / OFF All / OFF Click

OFF /240 to 5 sec.

°C/°F

ON/OFF

—>

[Back]

OK

snus|\ 1noqy
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Explanation of ltems in Each Menu

[Record Settings] Menu Items

[Stop Recording]
Click [OK] to stop recording.

[Start Recording]
Click [OK] to start recording.

[Method: IMMED(indv) / PGM(indv) / IMMED(grp) / PGM(grp)]
IMMED(indv): Starts recording immediately.

PGM(indv): Starts recording on the specified date and time.

IMMED(grp): Starts Group Recording immediately.
PGM(grp): Starts Group Recording on the specified date and time.
For details about Group Recording, see p.21.

[Recording Mode: Endless / One Time]
Endless: When the internal memory capacity becomes full, the most

recent data will be overwritten and recording will continue.

Onetime: Recording will be stopped at the moment the internal memory
capacity becomes full.
* See p.14 for an outline of info about recording and memory.

[Rec.Method: Instant / Average]
Select the recording method to be used.
Instant (Value): Records the instantaneous value at the set recording

interval.

Average (Value): Records the value as the average of the measurements
taken during the set recording interval.

See below for the sampling intervals when recording average values.

Recording
Interval

100 to 200ms

500ms to 1sec

2sec to 5min

10 to 60min

Sampling Interval

100ms

500ms

1sec

10sec

IMPORTANT

When recording average values, the first recorded value is invalid because an average
cannot be calculated.




[Rec. Interval: user-specified time]
Select from 18 choices: 100, 200, 500 msec./ 1, 2, 5, 10, 15, 20, 30 sec. /
1,2, 5,10, 15, 20, 30, 60 min. (default setting is 10 sec)

IMPORTANT
- It is not possible to make different recording interval settings for each channel.

[Rec. Channel: user-specified channel(s)]
Select the channel(s) for recording. It is possible to select to record using
one channel or a combination of channels from Ch1 - Ch4.

[CH1 T.C.Type - CH4 T.C.Type]
Select a thermocouple type for each channel: Type K, R, S, T, or J.

[Save/Restore Sett.]
By selecting [Save Settings], it is possible to save up to 4 types of
recording settings. All setting items in the [Record Settings] menu can be
saved and re-used, allowing you to save steps to repeat making the same
settings each time.
To use the saved recording settings (No.1 to 4), open them by selecting
[Restore Settings (No.1 to 4)]. [Restore Settings] screen will show a part of
the record settings as below.

STP.L1H=ecCHLIZ? EMACE
Festore Settings.

18zec & Inst.

CH1Z KK
IMPORTANT
- Only settings that have been saved from [Save Settings No.1 to 4] are available for
restoring.

- While a recording is in progress, recording settings can only be saved, but not restored.

- ALL saved settings will be deleted by executing [Return to Default] from the [Operation
Settings] menu. It is not possible to delete each saved setting individually.

snus|\ 1noqy
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[Data List] Menu Items (when recording stopped)

[Display Graph]
From the displayed list, select data you wish to view in a graph and tap
<ENTER>. See p.35 for details on how to read and control the view of
recorded data graphs.

[Export Selctd Data]
From the displayed list, select data to export to the SD memory card and
tap <ENTER>.

IMPORTANT
Multiple data files cannot be selected for exporting.

[Export All Data]
Select [OK] to export all data to the SD memory card.

[Delete Selctd Data]
While “Processing” is displayed on the LCD, do not perform any
other operations. This process may take a long time to complete.

Select the data you wish to delete from the displayed list, and tap
<ENTER>.

* If no operations are performed for a while on the data list screen, you'll return to the
previous screen.

* Deleting only a few (1-3) data readings from a list which contains a small number of
readings may have no effect on memory usage. (see p.41 for how to check memory
capacity)

[Delete All Data]
[On This Device Only]:
Select [OK] to delete all recorded data on the device currently in use.
[On All Devices]:

Select [OK] to delete all recorded data on the Master and all connected
Slave units all together.

* If you try to perform this operation on a Slave unit, the [Delete All Data] menu will
only show the [On This Device Only] option.



How to Read Graphs of Recorded Data

The graph can be scrolled on the display by using A'¥ or control wheel
operation to move to the left or right.

i 3
1 —@ 1309, 05 15:46: 13| Emass [e4.3 c] M |
TI i o—5
!l I =)
o el E—
3 b
by i FT R EH.CIXIS
4 = 5 ssﬁém._ 7
1. While scrolling, the time of recorded data appears on the top of the —
screen. >
2. The time of recorded data will switch to the measurement, a few g
seconds after you stop scrolling. =4
3. The measurement shown in 2 is the value of the point located at the %
center of the graph. 2
[

4. The bar on the bottom of the graph shows the portion of the data in the
view window.

Tapping <ENTER> allows you to change 5, 6 and 7.
5. Recording Channel

Select the desired channel to view a graph. If the displayed channel has
not been used for recording, you will see the “No Record” message.

6. Vertical Axis Scale (max/min)

Specify the range of the vertical axis to be displayed in the graph. The
max and min values can be set in steps of 10 degrees (C/F) in a range
of -300°C to 1800°C.

EX) “V.AXIS 0, 100” shows that the displayed range of the vertical axis
is from 0 to 100°C.
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7. Skimming Level (Horizontal Axis Scale)
Set skimming level for X-axis divisional boxes.

Skimx1 : The space between dots (data points on graph) is same as the
recording interval value

Skimxn : The space between dots (data points on graph) is “n” times
the recording interval value

Enlarged View

o :
ht : The horizontal axis of
There are ten data : the graph display shows
E.OI.nt.S (dchLS) in each : atotal of 100 dots.
ivisional box. :

| —
(10 dots per box) x 10 boxes = 100 dots

EX1) When recording interval is 100 ms and skimming level is "x1":

Each horizontal divisional box represents 1 sec (100 ms x 1 x 10
dots) with the total screen width showing 10 sec (1 sec x 10 boxes)
of recorded data.

EX2) When recording interval is 100 ms and skimming level is "x2":

Each horizontal divisional box represents 2 sec (100 ms x 2 x 10
dots) with the total screen width showing 20 sec (2 sec x 10 boxes)
of recorded data.
Use <ENTER> and <BACK> to move to the target item, then change
the value with A and V.



Scroll Screen

. @

Skimming Level
(Horizontal Axis Scale)

Vertical Axis Scale

Set the max and min
for the axis range.
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§ Recording Channel

Use A or ¥ to change.

Menu Screen

STPTE1BzecCHIZ  Obac:
Cata List

~Export ALl Data

* When changing settings as above, if no operations are performed or a change is not
confirmed with <ENTER>, the change will automatically be applied and the graph

will return to the “Scroll” mode.

Use A or ¥ to change.

Use A or ¥ to change.

snus|\ 1noqy
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[Data List] Menu Items (during endless recording)

[Expt Curr Data Now]
Use this to immediately export the data currently being recorded to the
SD memory card.
IMPORTANT
Memory cards are not included. Please purchase separately.

[Auto Data Export]
To prevent data loss in Endless mode, this menu will automatically export
the data to be overwritten to the SD memory card.
* When the internal memory capacity becomes full in Endless mode, the most recent
data will be overwritten and recording will continue.

Make sure to use a formatted blank SD card, or carry out a
“Quick Format”.

* During the [Auto Data Export] process, other operations cannot be performed except
for switching the LCD display between [Menu] - [Measurements] - [Trend Graph] by

pressing .
loiepLay|




Canceling [Auto Data Export]

If you wish to cancel the auto data export process, select [Back] and
tap <ENTER>.

RECt¥P18=zecCHIZ? OMact
[Auto Dats Export

(£ Cance L in:

| =SMCCEess |

The displayed message will be cleared when the process is terminated.

Restrictions on [Auto Data Export]
- USB communication cannot be used until the export process has been
completed.

- button is deactivated during the process.

- The export will be terminated in the following cases:
When the SD card is full
When using a 2GB or smaller SD card formatted as FAT16 and the
number of files reaches 128
When the SD card is removed
When an SD card write error occurs

snus|\ 1noqy
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[Memory Card] Menu ltems

[Quick Format]
Select [OK] to format your SD memory card for use in the MCR-4TC.

IMPORTANT

- This process will erase all recorded data from the SD memory card. It is recommended
to make backups of recorded data to a PC before formatting the memory card.

- It is not possible to erase individual data readings from the SD memory card.

- Do not turn off the power while the device and SD memory card are in communication.
If the device is running on batteries, make sure the batteries have power and are
installed correctly. If power is supplied by a PC over the USB bus, avoid power supply
disruption due to cable disconnection or power-saving settings on the PC.

[Memory Card Test]
Select [OK] to check if your SD memory card can be used with the
MCR-4TC. Not all commercially available SD memory cards can be used.
It is recommended to do this test before using.

IMPORTANT
If the memory card you wish to use passes the test but has problems when using, carry

out “quick format”.
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[Operation Settings] Menu ltems

[Set Contrast]
Adjust the LCD contrast with A and V. Tap <ENTER> to confirm the
contrast.

[Check Memory]
You can check the memory usage (% of capacity) and the number of
recorded data.

[Set Clock]

1. Tapping ¥ will change the selection item of the display in the order of
month, day, year, hour, minute, and second. By tapping <ENTER>, the
value for that item will flash.

2. While flashing, use AV to select the desired value and tap <ENTER> to
confirm.

3. Move to the next or previous setting item with ¥ or A.

* By tapping <BACK> while the selected item is flashing, the operation will be

canceled and flashing will stop.

[Time Zone] and [DST]
Set the time zone according to the region in which the MCR-4TC will be
used. Daylight savings time (DST) settings must be set manually.

IMPORTANT

- It is not possible to set the clock while recording is in progress.

- Please make sure that the date and time settings in the MCR-4TC are correct, if they
are not, the recording start time and recording time of downloaded data will be
incorrect.

- Clock settings (including time zone and DST) for the MCR-4TC can also be made from
your computer by using the supplied software MCR for Windows. When making
settings via the software, it is not necessary to carry out operations from the MCR-4TC.
For details, see the Help menu in the software.

[Beep]
This allows you to turn off the operation confirmation beeping sound.
* The “OFF Click” option will turn off the confirmation sound for touch panel operation
only.

snus|\ 1noqy
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[Key Lock]
This function automatically disables the use of the touch panel if no
operations occur during a set period of time. It helps prevent handling
mistakes.

Use A V¥ to specify the amount of time before the lock sets (in 1-sec
units).

* If you wish to turn ON the key lock immediately, press and hold
panel. The lock can be released by pressing and holding again.

[Unit of Temperature]
Select °C or °F.

[Burnout Detect.]

When this function is ON, it will detect thermocouple burnout and the
device will display the “ER B.OUT” message on the LCD.

STPP1HzecCHI? OMbaTE

27 .9 c«
ER B.OUT

[Return to Default]
By clicking [OK], the device will be initialized by returning it to the factory
default settings.

This will delete all data stored in the device and initialize the

settings. Please be careful when initializing a device as it is not
possible, after initialization, to retrieve previous settings info or
recover deleted or corrupted data.

Do not turn off the power of the MCR-4TC during initialization.
Termination of the initialization process may cause damage or
malfunction to the device.



— About Menus
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Using a PC with MCR-4TC

By using the supplied software, it is possible to make Device
Settings and Recording Settings from a computer, as well as
download recorded data from the MCR-4TC to your computer for
graph view and data analysis.

Installing the Supplied Software

The software installation procedure is as follows:

1. Start Windows and login using a User Account with Administrator
(Computer Administration) rights.

2. Place the CD-ROM into your CD or DVD drive.
3. The [Install Program] window will appear.

If the [Auto Play] window appears:
Click on [Run start.exe].

o
il
|

e

% DVD Drive (F)

Ay do thes aee anid Garme

If the [Install Program] window does not appear automatically:
Double click on the [start.exe] icon in the CD/DVD drive.



4. Select “Install MCR for Windows and click [Execute] to start the
installation.

Multichannel P sedee
or Windows

Saftware Main Wews

s trtal| MR fur Nirdoms

o recal | 1M Gk

B len W for Rirdsa lher's Gilde
@ viem e s

5. Follow the directions as they appear to complete the installation.

* If a window appears such as the one below during installation, click [Install] or
[Continue Anyway].

Would you like to install this device software?

Name: TandD Corporation Ports (COM & LPT)

& Publisher, T&D Corporation
‘) Don't Install

@ Youshould only install driver software from publishers you trust. How canl
decide which device software is safe to install?

Always trust software from "TD Corporation”.

After installation, MCR for Windows will appear in the Windows Start
Screen or Start Menu.

6. To view recorded data in a graph or print out, go back to step 4, and
install T&D Graph.

* For details about operations please see the “Help” menu in the software.

O1¥-HOIN Yyum Od e Buisn I
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Connecting the Device to a PC

1. Open MCR for Windows from the Start Screen or Start Menu.

2. Connect the device with the supplied USB cable to your computer.
The USB driver installation will start automatically.

IMPORTANT

- Make sure to install the supplied software MCR for Windows before connecting the
MCR-4TC to the computer.

- The USB device driver must be installed before trying to carry out USB communication.
After installing the USB device driver, your computer will be able to detect and
recognize any MCR-4TC unit that is connected with a USB communication cable.

- When connecting a MCR-4TC to a PC, connect only one unit at a time. If you connect
multiple units at the same time, they may not be recognized properly.

USB Communication Cable
(US-15C)

IMPORTANT
For the installation procedure of the software MCR for Windows, see p.44.
When the USB driver installation completes, on the upper right corner

of the software screen, you will see an icon showing the PC and
MCR-4TC connected via USB.

Dewnisading Riscorded Gat

= 6

[T e L

IMPORTANT

If you don't see this icon, the USB driver may not have been installed correctly. Please
see [Help for Unit Recognition Failure] in the Help menu, and check the USB driver.



Making Settings via PC

The following items are not included on the device menu, and can
only be set or changed from MCR for Windows by connecting the
device to a computer via USB.

Channel Name

Create and assign names to each of the channels to be used for record-
ing. Channel Names are used for display in T&D Graph.

1. In MCR for Windows, select the [Recording Start Settings] menu.

2. Place a check next to the desired channel(s) and enter each channel
name.

3. Click [Send Settings].

OLv-HOWN yum Od e buisn I
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Downloading Recorded Data to a PC

Data stored in the internal memory of MCR-4TC can be down-
loaded to a computer in either of the following two ways:

- Use an SD memory card to export recorded data and transfer to a PC.*

- Use MCR for Windows to download by connecting the device to a PC.
* For how to export recorded data to an SD memory card, see p.34.

IMPORTANT

When recording is in progress, there are restrictions on functions related to the SD
memory card.

Download Recorded Data using MCR for Windows

By connecting the device to a PC with a USB communication cable, it
is possible to download recorded data to a PC.

1. Open MCR for Windows.
2. Connect the device to your computer.

3. Click [Get List] in the [Downloading Recorded Data] window.

h MCR fiot Windews,
Lemrmesanen  Leelp

Doweined

Downlading Recomsed Data Dot Delads
Stait Reoisking(TC)

Recorcing Start Settings

4, Check the desired data in the list.

} MCR St Windens,
Commumcaton  Heln

Downinsding Fscorded Dats

fecareing Suan Setngs

Deaze In

Duata Detaity

LM Port Setings

Dok Settings




5. Click [Download].

| Downicading Recceded Duta n
| Data etain
dnte | [Delete ] TR RSN Conce Ch List

| Recording Start Time  10/13/2013 10743 8 m
ST | e tnienal e

Recorded Data File

One recorded data file (.r4T) is created for each recording session.

Storage Location of Recorded Data and File Name
The default setting is as follows.
Storage Folder:
C:\Users\username\Documents(or My Documents)\TandD Corp\MCR
File Name:
Serial number_rec.month_rec.day_rec.year_rec.time (hhmmss).r4T

F1 SEDCONIS A3 1113 16290747

To change the default storage folder, click D and specify the desired
folder. Button @ allows you to specify the desired file name as well as its
location.

OL-HOWW Yim Dd e Buisn I
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Download Recorded Data from all Connected MCR-4TC Units

1. Connect the Master unit to your computer via USB.
2. Get a data list for the Master. (see p.48)
3. Click [Search for Slave] to get data lists for the connected Slave units.

4. Place a check next to the target data.

* It is possible to select data from both the Master and Slave unit(s) for simultaneous
download.

5. Click [Download].

* If it takes too long to download data recorded from Slave units, it is also possible to
directly connect a Slave to the PC via USB and download individually. (You can
switch the USB cable from the Master to connect a Slave.)

IMPORTANT

Do not disconnect the USB cable during communication between a device and the PC.



Analyzing Recorded Data

Open Recorded Data

In the storage folder for the downloaded recorded data on your PC
(p.48), double click on the desired recorded data file. T&D Graph will be
opened and a graph displayed.

Print Graphs

1. Open recorded data from the T&D Graph.

2. Make any desired adjustments to the window size and aspect ratio to
be reflected in the printed graph.

3. In the [File] menu, select [Print Graph] to view the preview image of the
printed page. If necessary, go back to step 2 and change the aspect
ratio again.

4. o start printing, select [Print].

T&D Graph also enables you to:
- Insert memos, comments, and shapes on the graph
- Merge and filter recorded data
- Copy graphs
- Display data as a list
- Export the graph as text data (in CSV format)
* Refer to Help in T&D Graph for details about operations and procedures.

OLv-HOWN yum Od e buisn I
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Other

Troubleshooting

Q1. The computer does not seem to recognize the
MCR-4TC, why not?
A1. Please check the following:
Check the MCR-4TC
Check the USB connection between the computer and the
MCR-4TC.
Check the Computer
* Make sure that the software has been installed properly and is
working.

* The USB driver installation may not have been installed correctly.
Please see [Help for Unit Recognition Failure] in the Help menu,
and check the USB driver.

e Connect a different USB device (mouse, digital camera, etc...)
other than the MCR-4TC to your computer and see if it operates
properly.

e If your computer has more than one USB port, try connecting the
USB cable to a different port.

e If you have access to another computer, try seeing if
communication works with the other computer.

If after checking and trying the above there is no improvement

please contact the distributor where the product was purchased.

Q2. The first reading of recorded data is invalid data, why?
A2. One of two scenarios is possible:

¢ When recording average values, the first recorded value is invalid
because an average cannot be calculated.

 In Group Recording with MCR-4V as the Master, when the Preheat
function has been set to ON (recording method: instantaneous
values only) and the preheat time is set to longer than the waiting
time before recording start, the first data reading will be invalid
because preheating has not been completed.



Q3.
AS.

Q4.
A4.

Q5.
A5.

Is it possible to change the batteries while the unit is in
operation?

If the unit is connected to an AC adaptor or some other external
power source, it is possible to change the batteries. If only
batteries are being used as the power source, it is necessary to
stop recording before changing the batteries.

Is it possible to adjust or alter recorded data that has
been downloaded by the MCR-4TC?

In order to maintain the integrity and trustworthiness of the
recorded data, the software has been designed to not allow
modifications to be carried out on actual recorded data.

If it is necessary to edit recorded data, in T&D Graph save the
data to text file and use a common spreadsheet software, such
as Excel, to edit the text file data.

I get a “Write Error” when | try to export recorded data to
an SD memory card, what should | do?
Please check the following:

* Make sure the write protection switch on the SD memory card is
unlocked.

® Check if your SD memory card is supported by the MCR-4TC.
(See p.15)

e Perform a “Memory Card Test”. (See p.40)

® Perform a “Quick Format” for your SD card. (See p.40)

If after checking and trying the above you still get an error

message, please contact the distributor where the product was

purchased.

U0
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Q6. The software MCR for Windows does not start, why not?
AB6. Please check the following:

* The software may not have been installed correctly. Try reinstalling
MCR for Windows.

® Check to see if the software was installed with Administrator rights.

(For Windows 7 or earlier:)

® The .NET Framework 4 Client Profile may not have been installed
correctly. Follow the steps below to see if the .NET Framework 4
Client Profile has been installed correcily.

In the Control Panel, open [Program and Features] or [Uninstall a
Program].

Organize v  Uninstall/Change

Name Publisher
[m-] MCE for Window: T&D Corporation

icrasoft .NET Framewark 4 Client Profile Microsoft Corporation

Microsoft Chart Controls for Microsoft MET... Microsoft Corporation
¥ Microsoft Visual C-++ 2005 Redistributable  Microsoft Corporation
[=*] Microsoft Visual C++ 2008 Redistributable - ... Microsoft Corporation
[ Microsoft Visual C++ 2008 Redistributable - .. Microsoft Corporation
[ Microsoft Visual C++ 2008 Redistributable - ... Microsoft Corporation
[ Microsoft Visual C++ 2010 x86 Redistributa... Microsoft Corporation
< m

&: Microsoft Corporation Product version: 4.0.30319
4 Help link: http://go.microsof{

w

When the .Net Framework 4 Client Profile is not in the list above:

Try reinstalling MCR for Windows. The .Net Framework 4 Client
Profile will be automatically installed with the MCR for Windows.

When the .Net Framework 4 Client Profile is in the list above:



Follow the steps below to repair the .Net Framework 4 Client Profile.

1. Select Microsoft .NET Framework 4 Client Profile and click

[Uninstall or Change].
2. In the maintenance box, select “Repair .NET Framework 4 Client
Profile to its original state” and then click [Next]. Click [Finish] when

prompt.

T Framework 4 Client Profile Maintenaner nJ
Tou can repar your retalation of remeve i§ from the computer, ﬁﬁ
Plaisse select oe of the folliwins) oo

8 i T e 4 Chrd P 0 1 it vt

Remeve HET Framewert 4 Chent Prafie fom the eoeputer.

If after checking and trying the above there is no improvement

please contact the distributor where the product was purchased.

U0
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Specifications

MCR-4TC

Measurement Channels

Temperature 4ch

Input Method

Scanning Method, Differential Input, Each Channel Isolated

Compatible Sensors

Thermocouple: Type K, J, T, S, R

Measurement Units

°C, °F

Measurement Range

Type K: -270 to 1370°C
Type J: -210 to 1200°C
Type T: -270 to 400°C
Type S: -50 to 1760°C
Type R: -50 to 1760°C

Input Impedance

Approx. 1 MQ

Accuracy (1)

Thermocouple Measurement (Sensor inaccuracies not
included)

Type K, J, T: £(0.5°C + 0.3% reading) at -100°C or above
Type S, R : +(1.5°C + 0.3% reading) at 100°C or above

Cold Junction Compensation

+0.5°C at 10 to 40°C

+0.8°C other temperatures within the operating
environment of the logger

Measurement Resolution

0.1°C

Recording Method

Instantaneous or Average

Recording Interval

100, 200, 500 ms.
1,2, 5,10, 15, 20, 30 sec.
1,2, 5,10, 15, 20, 30, 60 min.

Logging Capacity (*2)

When recording 1 channel: up to 960,000 readings/ch

When recording 2 channels: up to 480,000 readings/ch
When recording 3 channels: up to 320,000 readings/ch
When recording 4 channels: up to 240,000 readings/ch

Recording Mode

Endless (Overwrite oldest data in the current recording
session when capacity is full) or One Time (Stop recording
when capacity is full)




Recording Start Method | Immediate Start or Programmed Start
(by individual logger or by group)
Group Recording Up to 4 units (16 channels) can be recorded simultaneously.

(Coupling of MCR-4TC and MCR-4V is possible. (*3))

Communication Interfaces

USB Communication

Communication Time

Download Times for Full Data via USB
- From the master or a single unit: Approx. 1 minute 30 seconds
- From a slave unit: Approx. 4 minutes 30 seconds

External Memory

SD Memory Card, SDHC Memory Card (*4)
(For Manual or Automatic Data Export)

Power AA Alkaline Battery x 2, AA Ni-MH Battery x 2, AC Adaptor
AD-05A2 or AD-05C2, USB Bus Power 5V 250mA
Battery Life (*5) For 4-Channel Measurement (AA Alkaline Battery)

Rec. RecMethod l”Sta\?atﬁJneeous Average Value
Interval
100ms Approx. 5 days Approx. 5 days
500ms Approx. 7 days Approx. 7 days
1sec Approx. 21 days Approx. 7 days
5sec or longer Approx. 60 days Approx. 21 days

Input Terminal

Screwless Terminals

<Compatible Wires>

Single Wire: @0.32 to @0.65 mm (AWG 28 - 22)

Twisted Wire: 0.08 to 0.32 mm”® (AWG 28 - 22), @0.12 mm
or more in diameter

Stripping Length: 9 to 10 mm

Isolation CH1, CH2, CH3, CH4, and USB are isolated. (Battery
terminals are not isolated from the CH1-CH4 input terminals.)
CH1-CH4 Maximum Applied Voltage: +50 V
Electrical Isolation Resistance: 50 MQ or more (DC+250 V)

Dimensions H 120 mm x W 75 mm x D 32 mm

Weight Approx. 140 g

Operating Environment

Temperature: 0 to 50°C
Humidity: 90%RH or less (no condensation)

U0
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Software (MCR for Windows)

Compatible OS (*6) Microsoft Windows 10 32 / 64 bit

Microsoft Windows 8 32 / 64 bit
Microsoft Windows 7 32 / 64 bit

Display Languages (*7) | English

Other The Microsoft .NET Framework 4 is required.

*1:

N

*3:

*4:

*

o

*6:
*7:

MCR-4TC has superior noise filter, but the measurement may sometimes fluctuate due
to strong noise. Especially when the recording interval is set to 200 ms or less, the
filtering becomes weaker and hence the fluctuation may become greater.

: If the logging capacity is not filled at the end of one recording session, the logger can

record up to 30 times.
Group Recording may not be started depending on the recording or measurement
interval specifications of the connected Master unit.

Please check the T&D Website for information on memory cards whose operation has
been confirmed.

: Battery life varies depending upon the ambient temperature, the recording interval, the

number of measurement channels, and the frequency of data export to a memory card.
For installation, it is necessary to have Administrator (Computer Administrator) rights.

We recommend using an operating system in the same language as the display
language. Operation in different languages is not guaranteed.

The specifications listed above are subject to change without notice.



Option

AC Adaptor AD-05A2 / AD-05C2
USB Mini-B Type

Input : AC100 to 240V
Output:DC5V, 1A

Frequency : 50/60Hz

Cable Length : 1.5m %

AD-05A2 AD-05C2
Plug Type El (aD)}



Product Support
For support, please contact the distributor from which you
purchased the product.

A list of distributors can be found at:
http://www.tandd.com/purchasing/

Product Information
Product information can be found at:
https://www.tandd.com/product/

Multichannel Temperature Recorder MCR-4TC
User's Manual

T&D CORPORATION
817-1 Shimadachi, Matsumoto, Nagano 390-0852, Japan

Website: http://www.tandd.com/
FAX: +81-263-40-3152 E-mail: support@tandd.com




Provisions for Free Repair

If the unit does not work properly despite the fact that the customer used it properly and in line with the

manual, the unit shall be repaired free of charge through the distributor which sold the unit.

IS}

If the customer requests free repair because of trouble within the warranty period, bring or send the unit

along with the warranty to the distributor.

w

If you have moved after purchasing, or there are difficulties contacting the distributor from which you

purchased the unit, please contact T&D directly for service.

IS

N}

3.
4.

Free repair is not available in the following cases even though it is within the warranty period:
1.

Trouble or damage was caused by careless operation, natural disaster, fire, public pollution, or use
of a power source other than specified.

If repair, adjustment, disassembly or modification of the unit has been carried out by a person other
than a T&D authorized engineer.

Trouble or damage was caused by transportation, movement or dropping of the unit after purchase.
Failure to submit the warranty or failure to fill in all items required in the warranty.

5. The warranty cannot be reissued.

This warranty only promises customers free repair within the period and conditions clarified in this warranty.
Therefore, the customer's legal rights will not be limited by this warranty. For further information on repair
and other service questions after the termination of the warranty period, contact your distributor.





